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 Xilinx ISEافضاس  اص ػشی سإٞٙبٞبی ٘شْ ا٘ذاصی ػشیـ ٞبی سإٞٙبی ٘لت ٚ ساٌٜفتبسدس 

Design Suite ٜٛثب  ػبصی ؿجیٝ دس ایٗ سإٞٙب ثٝ كٛست وّی تجییٗ ؿذ.  افضاس ی وبس ثب ایٗ ٘شْ ٘ح

ISim .سا ثٝ عٛس وبُٔ فشا خٛاٞیذ ٌشفت 

سإٞٙبی لجُ اص ایٗ ػشی سا ٔغبِقٝ  ثذیٟی اػت ٌفتبس پیؾ سٚ ثشای آٖ دػتٝ اص افشادی وٝ

لافبت ثیـتش دس ایٗ عوؼت اٚ خٛاٞبٖ  آؿٙبیی اثتذایی داؿتٝ  افضاس ٘شْثب ایٗ  ٘ذ ٚ یب افشادی وٝاٜ وشد

 ٔفیذ خٛاٞذ ثٛد. صٔیٙٝ ٞؼتٙذ،
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پشداصیٓ. ثشای ایٗ وبس دس اثتذا عجك آ٘چٝ دس  ٔی  ISimػبص  ؿجیٝ  دس ایٗ فلُ ثٝ ثشسػی دلیك

آٖ اضبفٝ ٕ٘ٛدٜ ٚ دس  ٝی خٛد سا ثٞب فبیُػبصیٓ ٚ  ٔی ISEٌفتٝ ؿذ یه پشٚطٜ دس  ا٘ذاصی ساٜسإٞٙبی 

وٙیٓ وٝ ٔشاحُ تقشیف پشٚطٜ ٚ اضبفٝ  ٔیوٙیٓ. دس ایٗ فلُ فشم  ٔی ػبصی ؿجیٟٝ٘بیت پشٚطٜ سا 

 ػبصی ٞؼتیٓ. ا٘دبْ ؿذٜ ٚ دس آػتب٘ٝ ؿجیٝ ٞب فبیُوشدٖ 

دس  ذؿٛیذ ٚ ٔغٕئٗ ؿٛیی پشٚطٜ ٞب ٚاسد ٚیظٌی Edit > Design Propertiesاص ٔؼیش 

 ا٘تخبة ؿذٜ اػت. ISim ،لؼٕت ؿجیٝ ػبص

 

(1-2) شکل ساز پريشٌ بٍ عىًان شبیٍ  ISimاوتخاب  
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 Process ،ISimی  سفتٝ ٚ دس پٙدشٜ  Simulationسٚی فجبست  Designی  ػپغ دس پٙدشٜ

Simulator   ٚ اثتذا سٚی سا ثبص وٙیذBehavioral Check Syntax  سفتٝ ٚ دس كٛستی وٝ عشاحی ؿٕب

ٔغبثك  ISimی  وّیه وٙیذ. ثب ایٗ وبس پٙدشٜ Simulate Behavioral Modelسٚی  ،ثذٖٚ اؿىبَ ثٛد

وٙٙذٜ  ـٕلاصْ ثٝ روش اػت وٝ دس ایٗ فلُ ٕٞچٖٛ فلَٛ ٌزؿتٝ اص ثّٛن خ ؿٛد. ٔیؿىُ صیش ثبص 

 اػتفبدٜ ؿذٜ اػت.

 

(2-2) شکل ISimی کلی  پىجرٌ 

 ISimی  ی مختلف پىجرٌَا بخش -2-1

 اصلی 1وًار ابسار -2-1-1

ایٗ ٘ٛاس اثضاس ؿبُٔ وّیذٞبی ٔختّفی اػت وٝ افٕبِی سا وٝ أىبٖ تىشاس آٟ٘ب صیبد اػت سا دس 

 ٌیشد. ٔیثش 

                                           
0 Toolbar 
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(3-2) شکل ابسار اصلیوًار  

 ي فرآیىذَا َا ی ومًوٍ پىجرٌ -2-1-2

 دٞذ. ٔیی ٔٛخٛد دس عشاحی سا ثٝ كٛست ػّؼّٝ ٔشاتجی ٘ـبٖ ٞب ایٗ پٙدشٜ، ثّٛن

 

(4-2) شکل ي فرآیىذَا َا ی ومًوٍ پىجرٌ 

ٚاحذ ؿبُٔ یه  وٝ پشٚطٜ یه فبیُ تؼت ٚخٛد داسد وٙیذ دس ایٗ ٔیٕٞبٖ عٛس وٝ ٔـبٞذٜ 

 اػت. Initialٚ یه  وٙٙذٜ خٕـ
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 مىبعی َا فایل -2-1-3

 ػبصی لشاس داسد. ٞبی ٔشثٛط ثٝ ؿجیٝ ی ٔٙبثـ خبیی اػت وٝ دس آٖ فبثُ ثشٌٝ

 

(5-2) شکل ی مىبعَا فایل 

1اشیای  پىجرٌ -2-1-4
 

ؿٛد. ٞش وذاْ اص ایٗ  ٔیدس عشاحی ٘ـبٖ دادٜ  ٛدی ٔٛخٞب ػیٍٙبَٚ  ٞب ای اػت وٝ دس آٖ پٛست پٙدشٜ

 ثبؿٙذ: ٔیداسای ػٝ ٔـخلٝ  ٞب ػیٍٙبَ

                                           
0 Objects 
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0) Object Name ٘بْ ػیٍٙبَ ٕٞشاٜ ثب فلأتی وٝ ٘ٛؿ ػیٍٙبَ سا )اص ِحبػ ٚسٚدی یب خشٚخی :

 دٞذ. ٔیثٛدٖ( ٘ـبٖ 

3) Valueٔمذاس ػیٍٙبَ دس صٔبٖ وٙٛ٘ی : 

2) Data Typeتٛا٘ذ اص ٘ٛؿ ٔٙغمی یب آسایٝ ثبؿذ. ٔیوٙذ وٝ  ٔی ق: ٘ٛؿ دادٜ ػیٍٙبَ سا ٔـخ 

 

(6-2) شکل ی اشیا پىجرٌ 
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 پىجرٌ شکل مًج -2-1-5

وٙیذ وٝ دس ػتٖٛ اَٚ آٖ ٘بْ ٚ  ٔیی ٔذاس سا ٔـبٞذٜ ٞب ٚسٚدی ٚ خشٚخیدس ایٗ پٙدشٜ ؿىُ ٔٛج 

٘ٛؿ ػیٍٙبَ، دس ػتٖٛ دْٚ ٔفذاس آٟ٘ب دس خبیی وٝ ٔىبٖ ٕ٘ب سٚی آٖ اػت ٚ دس ػتٖٛ آخش ٞٓ 

 لشاس داسد. ٞب ٔٛج ؿىُ

 

(7-2) شکل مًج شکلی  پىجرٌ 

 يیرایشگر مته -2-1-6

ی ٞب ٝ ؿذٜ اػت تب ٚیشایؾتقجی ISimدس  HDLی ٞب ایٗ پٙدشٜ ثشای دػتشػی ٔؼتمیٓ ثٝ وذ

ا٘دبْ ٌیشد. ایٗ پٙدشٜ ثب وّیه وشدٖ سٚی ٞش فبیُ ٔٙجـ  ISimاحتٕبِی ثٝ كٛست ٔؼتمیٓ دس خٛد 

 دٞذ. ٔیُ ٔزثٛس سا ٘ـبٖ یؿٛد ٚ فب ٔیثبص 
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(8-2) شکل مته يیرایشگر 

  Consoleی  پىجرٌ -2-1-7

 ٚاسد وٙیذ. سا ٔـبٞذٜ ٚ دػتٛسات خٛد سا  ISimی ٞب تٛا٘یذ پیبْ ٔیت وٝ دس آٖ ػای ا پٙدشٜ

 

(9-2) شکل  Consoleی  پىجرٌ 

 آزمًن طراحی -2-2

عشاحی خٛد سا دس آٖ ثیبصٔبییذ ثشای ایٗ  ثبص ؿذ، ؿٕب ثبیذ ثتٛا٘یذ ISimی  پغ اص ایٙىٝ پٙدشٜ
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 افضاس ٔؼّظ ثبػیذ وٝ فجبستٙذ اص: وبس ثبیذ ثٝ ا٘دبْ ثشخی افٕبَ دس ایٗ ٘شْ

 ٜٞبی دادٜ ؿذٜ ػبصی ثب افٕبَ تغییشات ٚ ٔـبٞذٜ پیبْ ؿجیٝ ی اخشای اِٚیٝ ٚ دٚثبس 

  اضبفٝ وشدٖ ػیٍٙبَ اص ٚاحذTestbench ٞب ٚ یب ػبیش ثّٛن 

 ٜٚٞب ػیٍٙبَثشای ٕ٘بیؾ ٚ تـخیق ثٟتش  ٞب ٚ تمؼیٓ وٙٙذٜ ٞب اضبفٝ وشدٖ ٌش 

  ثشای تحّیُ دلیك ٚ آػبٖ تش ٞب ػیٍٙبَتغییش ٔـخلبت 

 ػبصی ٔىبٖ ٕ٘بٞب ثشای تقییٗ ٘مبط فغف ؿجیٝٞب ٚ 0اػتفبدٜ اص ٘ـب٘ٝ ٌزاس 

 ٞب ػیٍٙبَی ٕ٘بیؾ ٞب تغییش ثضسٌٕٙبیی ٚ ػبیش ٚیظٌی 

 ی ٔختّف عشاحیٞب اػتفبدٜ اص چٙذ پٙدشٜ ؿىُ ٔٛج ثشای تحّیُ ٕٞضٔبٖ ثخؾ 

 اضافٍ کردن سیگىال -2-2-1

س ثٝ عٛ ٞب ػیٍٙبَ ،ثبص ٕ٘ٛدٜ ایذ ISE Project Nevigatorسا اص عشیك   ISimدس كٛستی وٝ 

ؿٛ٘ذ.دس غیش ایٗ كٛست لجُ اص ا٘دبْ فّٕیبت  ی ؿىُ ٔٛج ؽبٞش ٔی خٛد ثٝ خٛد دس پٙدشٜ

ی ؿىُ ٔٛج اضبفٝ وٙیذ. ثشای ایٗ وبس دس  سا ثٝ پٙدشٜ ٞب ػیٍٙبَػبصی ثبیذ ثٝ عٛس دػتی  ؿجیٝ

خٛاٞیذ  ٔییب ٞش ٚاحذ دیٍشی وٝ  TestBenchسٚی ٚاحذ  Instances and Processesی  پٙدشٜ

سا ا٘تخبة  Add To Wave Window ی ٌضیٙٝی آٖ سا اضبفٝ وٙیذ ساػت وّیه وشدٜ ٚ ٞب ػیٍٙبَ

  وٙیذ.

                                           
0 Marker 
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 سازی شبیٍ 1ی شريع ديبارٌ -2-2-2

ٚ یب ٘ٛؿتٗ  اػت وٝ ثٝ ؿىُ  ٘ٛاساثضاس اكّیاص   ؿشٚؿ دٚثبسٜی  تٛا٘یذ تٛػظ دوٕٝ ٔی

وشدٜ ٚ یه ثبس دیٍش  ػبصی لجّی سا خٙثی ، ؿجیEnterٝصدٖ ٚ  consoleی  دس پٙدشٜ restartوّٕٝ ی 

 آٖ سا ا٘دبْ دٞیذ.

 

(10-2) شکل سازی  شبیٍی  شريع ديبارٌ 

 زماوی مشخص ی سازی در بازٌ شبیٍ -2-2-3

سفتٝ ٚ دس خبی ٔخلٛف صٔبٖ  ٘ٛاساثضاس اكّیدس یه صٔبٖ ٔـخق سٚی  ػبصی ؿجیٝثشای 

 Consoleی  سا ثض٘یذ ٚ یب دس پٙدشٜ ی  سد وشدٜ ٚ دوٕٝاصٔبٖ ٔٛسد ٘ؾش سا ٚ  یقٙی 

 سا ثض٘یذ. Enterسا ٚاسد وٙیذ ٚ  run 10 nsفجبست 

                                           
0 Restart 
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(11-2) شکل واوًثاویٍ 10برای  کىىذٌ جمعسازی  شبیٍ 

 َا سیگىالبىذی  گريٌ -2-2-4

ثؼیبس صیبد ثبؿذ ٚ ؿٕب ٔدجٛس ثبؿیذ ثشای آ٘بِیض  ٞب ػیٍٙبَدس یه عشاحی ٕٔىٗ اػت تقذاد 

ای  ٔـىُ چبسُٜ ایٗ حثشای  ISimی ؿىُ ٔٛج سا ثبلا ٚ پبییٗ وٙیذ.  كفحٝ ٞب ػبصی ثبس ؿجیٝ

ٞبی  ثٙذی وشدٜ ٚ دس ٞش صٔبٖ تٟٙب ٌشٜٚ ی عشاحی سا دػتٝٞب ػیٍٙبَتٛا٘یذ  ٔیا٘ذیـیذٜ، ثٝ عٛسی وٝ 

 ٞب ٔـبٞذٜ ٚ ثمیٝ سا ثؼتٝ ٍ٘ٝ داسیذ. ی آٖٞب ػیٍٙبَثب ثبص ٚ سا تحت آ٘بِیض 

خٛاٞیذ دس یه ٌشٜٚ ثبؿٙذ سا ٕٞضٔبٖ  یی سا وٝ ٔیٞب ػیٍٙبَثشای ایدبد چٙیٗ ػبص ٚ وبسی 

سا ا٘تخبة وٙیذ. دس ٟ٘بیت ٘بْ ٔٙبػجی  New Group ی ٌضیٙٝا٘تخبة ٚ ثب ساػت وّیه وشدٖ سٚی آٟ٘ب 

ت ػثٝ حبِت لجُ ثشٌشد٘ذ سٚی ٌشٜٚ سا ٞب ػیٍٙبَخٛاٞیذ  ٔیسٚی ٌشٜٚ ثٍزاسیذ. دس كٛستی وٝ 

 سا ثض٘یذ. Ungroupوّیه وشدٜ ٚ 

تمؼیٓ ؿذٜ ٚ ٌشٜٚ  ٞب ٚ خشٚخی ٞب ثٝ دٚ دػتٝ ٚسٚدی وٙٙذٜ خٕـی ٞب ػیٍٙبَصیش  دس ؿىُ
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 ی آٖ لبثُ ٔـبٞذٜ اػت.ٞب ػیٍٙبَثبص ٚ  ٞب خشٚخی

 

(12-2) شکل ی يريدی ي خريجی بٍ دي دستٍ کىىذٌ جمعی َا سیگىالبىذی  گريٌ 

 اضافٍ کردن درایًر -2-2-5

یبثذ عشاح ٘یبص داسد تب ثذا٘ذ ٞش ػیٍٙبَ ٔتقّك  ٔیافضایؾ  ٞب ػیٍٙبَصٔب٘ی وٝ تقذاد ٚاحذٞب ٚ 

ی ؿىُ ٔٛج ساػت وّیه  دس پٙدشٜ ٞب ػیٍٙبَثٝ چٝ ٚاحذی اػت. ثشای ایٗ وبس سٚی ثخؾ ٘بْ 

ی ٔتقّك ٞب ػیٍٙبَسا ا٘تخبة وٙیذ. پغ اص تقییٗ ٘بْ آٖ سا ثٝ ثبلای  New Driverی  ی ٌضیٙٝوشدٜ ٚ 

 ثٝ آٖ ٔٙتمُ وٙیذ.

 Testbenchی ٞب ػیٍٙبَثٝ  وٙٙذٜ خٕـی ثّٛن ٞب ػیٍٙبَصیش اثتذا  ثٝ فٙٛاٖ ٔثبَ دس ؿىُ

 اضبفٝ ؿذٜ ػپغ دسایٛس ٔشثٛط ثٝ ٞش وذاْ اضبفٝ ؿذٜ اػت.
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(13-2) شکل ي ياحذ تحت آزمًن Testbenchاضافٍ کردن درایًر  

 1ی زیر ياحذَاَا سیگىالاضافٍ کردن  -2-2-6

ٞبی عشاحی سا ٞٓ ٔـبٞذٜ ی صیش ٚاحذٞب ػیٍٙبَػبصی ٘یبص داسیذ تب سفتبس  ٌبٞی ؿٕب دس ؿجیٝ

سٚی صیش ٚاحذ ٔشثٛعٝ ثشٚیذ.  Instances and Processesی  ٚ آ٘بِیض ٕ٘بییذ. ثشای ایٗ وبس دس ثشٌٝ

ؿٛ٘ذ. ثٝ فٙٛاٖ ٔثبَ دس  ٔی٘ـبٖ دادٜ  Objectsی  ی آٖ ٚاحذ دس پٙدشٜٞب ػیٍٙبَیذ دیذ وٝ اٞخٛ

 اػت سا ا٘تخبة وشدٜ ایٓ. وٙٙذٜ خٕـذ تحت آصٖٔٛ وٝ دس ٚالـ ٚاحذ اكّی حؿىُ صیش ٚا

                                           
0 Sub-Module 



 ISim: ؿجیٝ ػبصی ثب ْدٚ فلُ                                            ISEافضاس  سإٞٙبی اػتفبدٜ اص ٘شْ
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(14-2) شکل اوتخاب یک زیرياحذ 

ی ؿىُ ٔٛج ٔٙتمُ ٕ٘بییذ سٚی ٘بْ  پٙدشٜی صیشٚاحذ سا ثٝ ٞب ػیٍٙبَاٌش للذ داسیذ تٕبْ 

 Add To Wave ی ٌضیٙٝساػت وّیه وشدٜ ٚ  Instances and Processesی  صیشٚاحذ دس ثشٌٝ

Window  سا ا٘تخبة وٙیذ. أب اٌش للذ ٔـبٞذٜ سفتبس ػیٍٙبَ خبكی اص ایٗ ٚاحذ سا داسیذ آٖ سا اص

0ٔٛج ثیٙذاصیذثىـیذ ٚ دس كفحٝ ی ؿىُ  Objectsی  پٙدشٜ
 Objectsی  دس ضٕٗ ثبلای كفحٝ .

فقبَ ثٕب٘ٙذ ٚ یب وذاْ ٘ٛؿ  ٞب ػیٍٙبَتٛا٘یذ تٛػظ آٖ تقییٗ وٙیذ وٝ وذاْ ٘ٛؿ  ٔیٔٙٛیی ٚخٛد داسد وٝ 

 ی ٔشثٛعٝ ٕ٘بیؾ دادٜ ٘ـٛ٘ذ. ؿٛ٘ذ ثٝ ایٗ ٔقٙی وٝ دس پٙدشٜ فقبَ غیش

سا وـیذٜ ٚ  ٞب ٞؼتٙذ. آٖ ٞب ٚسٚدی Objectsی  دس پٙدشٜ َی فقبٞب ػیٍٙبَٟب تٙدس ؿىُ صیش 

ی اضبفٝ ٞب ػیٍٙبَایٓ. دلت داؿتٝ ثبؿیذ وٝ ثشای ٔـبٞذٜ ؿىُ ٔٛج  ی ؿىُ ٔٛج ا٘ذاختٝ ثٝ پٙدشٜ

                                           
0 Drag and Drop 
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 ػبصی سا دٚثبسٜ ؿشٚؿ ٚ اخشا وٙیذ.ٝ ثبیذ ؿجی ،ؿذٜ

 َا سیگىالی َا تغییر يیژگی -2-2-7

 ٞب ؿٛیذ وٝ ٌبٞی تغییش آٖ ٔیآؿٙب  ٞب ػیٍٙبَدس ایٗ لؼٕت ثب یه ػشی اص خلٛكیبت 

 ٕ٘بیذ. ٔیػبصی  وٕه صیبدی ثٝ آ٘بِیض ثٟتش ؿجیٝ

 تغییر فرمت وام سیگىال 

ISim  ْی ؿىُ ٔٛج تٟٙب اص ٘بْ ػیٍٙبَ دس  دس پٙدشٜ ٞب یٍٙبَػثشای خٛا٘بیی ساحت تش ٘ب

اسد عشاح خٛاٞبٖ ایٗ اػت وٝ ثذا٘ذ ٛدس حبِی اػت وٝ دس ثقضی ٔوٙذ. ایٗ  ٔیٚاحذ ٔشثٛعٝ اػتفبدٜ 

ثبؿٙذ. ثشای دیذٖ ایٗ ٔذَ ٕ٘بیؾ سٚی ػیٍٙبَ ساػت  ٔیٔتقّك ثٝ وذاْ ٚاحذ  ٞب ػیٍٙبَٞش وذاْ اص 

 Testbenchاص فبیُ   Sسا ثض٘یذ. دس ؿىُ صیش ایٗ فُٕ ثشای خشٚخی  Name >Longوّیه وشدٜ ٚ 

 ا٘دبْ ؿذٜ اػت. وٙٙذٜ خٕـاص فبیُ  Aٚ ٚسٚدی 
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(15-2) شکل وشان دادن وام کامل سیگىال 

 سیگىال یاتغییر مبى 

ی آٟ٘ب ثشای ٔب ٟٔٓ اػت ٚ فشم ثیت اص یه  ی ػیٍٙبَ دس خغٛعی وٝ ٔمذاس دادٜبتغییش ٔجٙ

وٙذ. ثشای ایٗ وبس سٚی ػیٍٙبَ ٔشثٛعٝ ساػت  ٔیس تحّیُ سفتبس ػیٍٙبَ ثیـتش اػت، وٕه ؿبیب٘ی د

ٞـت، ؿب٘ضدٜ، دٜ دٞی  یبی ٔختّفی ٔب٘ٙذ ٔجٙٞب ا٘تخبة ISimسا ا٘تخبة وٙیذ.  Radixوّیه وشدٜ ٚ 

تٛا٘یذ ٔتٙبػت ثب ٘یبصتبٖ یىی سا ا٘تخبة  ٔیٌزاسد وٝ  ٔیسا پیؾ سٚی ؿٕب   ثبفلأت ٚ ثی فلأت

 ثبؿذ. ٔی فقبَ غیشته ثیتی اػت ایٗ ثخؾ  ٞب ػیٍٙبَوٙیذ. دس عشاحی ٔب چٖٛ تٕبْ 



 ISim: ؿجیٝ ػبصی ثب ْدٚ فلُ                                            ISEافضاس  سإٞٙبی اػتفبدٜ اص ٘شْ
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 تغییر روگ سیگىال 

سً٘ آٖ سا فٛم وٙیذ. ثشای ایٗ وبس سٚی  ٞب ػیٍٙبَتٛا٘یذ ثشای ثٟتش دیذٜ ؿذٖ ثقضی  ٔی

 سً٘ ٔٛسد ٘ؾش سا ا٘تخبة وٙیذ. Signal Colorػیٍٙبَ ساػت وّیه وشدٜ ٚ ثب ا٘تخبة 

 

(16-2) شکل َا سیگىالتغییر روگ  

 شکل مًج ی رخیرٌ سازی صفحٍ -2-2-8

ایذ لبثُ رخیشٜ ػبصی اػت. ثشای ایٗ  ایدبد ٚ احیب٘ب تغییش دادٜ ػبصی ؿجیٝؿىُ ٔٛخی وٝ ثب 

 < Fileتٛا٘یذ اص عشیك  ٔی ٞب ثشای فبیُ خٛد ا٘تخبة وٙیذ. ثقذ ٔیسا ثض٘یذ ٚ ٘ب File >Save Asوبس 

Open .آٖ سا ثبص ٚ ٔـبٞذٜ وٙیذ 
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 وما اضافٍ کردن مکان -2-2-9

الذاْ وشدٜ ٚ   Edit > Go toثشای اضبفٝ وشدٖ چٙذیٗ ٔىبٖ ٕ٘ب سٚی ؿىُ ٔٛج یب اص عشیك 

ٚاسد وٙیذ ٚ یب ثٝ كٛست دػتی ٔىبٖ ٕ٘بی  دس صٔبٖ ٔٛسد ٘ؾش سا 

ثض٘یذ. دس ؿىُ صیش ایٗ وبس ثٝ سا  وّیذ  ٘ٛاساثضاس اكّیػپی اص  اكّی سا ثٝ خبی ٔٛسد ٘ؾش ثجشیذ.

 ی ٔختّف ا٘دبْ ؿذٜ اػت.ٞب دفقبت دس صٔبٖ

 

(17-2) شکل وما اضافٍ کردن مکان 

 ومایی بسرگ -2-2-11

ؿٛد  ٔیسا ا٘تخبة وٙیذ وٝ ثبفث  تٛا٘یذ اص ٘ٛاساثضاس اكّی  ٔیثشای تٙؾیٓ ثضسٌٕٙبیی 

 دس كفحٝ ٕ٘بیؾ دادٜ ؿٛد. ػبصی ؿجیٝ صٔبٖ ؿىُ ٔٛج تب آخش
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1کاملبسرگىمایی در دیذ  
(18-2) شکل 

 تٛا٘یذ ثضسٌٕٙبیی سا تغییش دٞیذ. ٔیاص ٘ٛاساثضاس اكّی   ٚ  تٛػظ وّیذٞبی 

 گیری زمان اوذازٌ -2-2-11

ٔىبٖ، ٔىبٖ ٕ٘ب سا دس ٔجذا لشاس دادٜ ٚ دس ٘ضدیىی ٔىبٖ ی ثیٗ دٚ  ثشای ا٘ذاصٜ ٌشفتٗ فبكّٝ

ٔملذ ثشػب٘یذ.ٕ٘ب سٚی خٟت ٔخبِف ٔملذ وّیه وشدٜ ٚ ٔٛع سا اص سٚی ٔىبٖ ٕ٘ب فجٛس دادٜ ٚ ثٝ 

                                           
0 Full View 
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(19-2) شکل گیری زمان اوذازٌ 

 صفحٍ جذیذ شکل مًج -2-2-12

دس كٛستی وٝ ٘یبص داسیذ چٙذیٗ كفحٝ ٔٛج ایدبد وشدٜ ٚ دس ٞش وذاْ چٙذ ٚ یب ٕٞٝ 

سا ا٘تخبة وٙیذ.  Wave Configurationٚاسد فُٕ ؿذٜ ٚ  File >Newسا ٔـبٞذٜ وٙیذ اص  ٞب ػیٍٙبَ

 ٌفتٝ ؿذٜ دس آٖ پٙدشٜ ثٍٙدب٘یذ.ی ٔٛسد ٘ؾشتبٖ سا عجك سٚاَ ٞب ػیٍٙبَػپغ 

1زدایی  اشکال -2-3
 طراحی 

ثشای ایٗ  ISimسػذ.  ٔی صدایی  اؿىبَی  ی آصٖٔٛ عشاحی ٘ٛثت ثٝ ٔشحّٝ پغ اص ٔشحّٝ

، 3ی ا٘فلبَ دٞذ وٝ ثشخی اص آٟ٘ب فجبستٙذ اص: تٙؾیٓ ٘مغٝ ٔیٔشحّٝ ٘یض أىب٘بتی دس اختیبس وبسثش لشاس 

 ثبصٌـت ثٝ وذ ٔٙجـ ٚ ... .

                                           
0 Debugging 

3 Breakpoint 
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 ی کذ مىبعٌ مشاَذ -2-3-1

سٚی ٘بْ ٚاحذ ساػت وّیه  Instances and Processesی  ثشٌٝوذ ٔٙجـ دس  ی ثشای ٔـبٞذٜ

 سا ا٘تخبة ٕ٘بییذ. Go To Source Codeوشدٜ ٚ 

 

(20-2) شکل ی کذ مىبع مشاَذٌ 

 ی اوفصال وقطٍ -2-3-2

ؿٛد.  ٔیػبصی تب آ٘دب ا٘دبْ ؿذٜ ٚ ٘تبیح ٕ٘بیؾ دادٜ  ؿجیٝای اػت وٝ  ٘مغٝ ی ا٘فلبَ ٘مغٝ

خٛاٞذ خّٛ ثشدٜ ٚ اثشات آٖ سا  ٔیػبصی سا تب خبیی وٝ  تٛا٘ذ اػتفبدٜ وٙذ تب ؿجیٝ ٔیاص ایٗ ٘مغٝ  حعشا

 ػبصی ثخؾ ثبلی ٔب٘ذٜ سا اص ػش ٌیشد. ٔـبٞذٜ وٙذ. ػپغ ؿجیٝ

ٔٙجـ سفتٝ ٚ وٙبس فذد خظ وّیه وٙیذ ٚ یب  ، ثٝ خظ ٔشثٛعٝ اص وذی ا٘فلبَ ٘مغٝثشای ایدبد 

ػبصی سا دٚثبسٜ  سا ا٘تخبة ٕ٘بییذ. ػپغ ؿجیٝ Toggle Breakpoint ی ٌضیٙٝثب ساػت وّیه وشدٖ 

سفتٝ ٚ دس آٖ خب  ی ا٘فلبَ ٘مغٝوٝ اخشا سا صدیذ ٔتٛخٝ خٛاٞیذ ؿذ وٝ اخشا تب  ٔیؿشٚؿ وٙیذ ٍٞٙب
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 وٙذ. ثشای اخشای ثمیٝ دٚثبسٜ ثبیذ وّیذ اخشا سا ثض٘یذ. ٔیتٛلف 

 وٙیٓ. ٔیایدبد  ی ا٘فلبَ ٘مغٝوٙیذ. اثتذا دٚ  ٔیی صیش ٔـبٞذٜ ٞب ایٗ سٚ٘ذ سا دس لبِت ؿىُ

 

(21-2) شکل ی اوفصال ایجاد وقطٍ 

 ص٘یٓ. ٔی( سا ( ٚ پغ اص آٖ اخشا)ؿشٚؿ دٚثبسٜ ) ی ٌضیٙٝ
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(22-2) شکل ی اوفصال ايل تًقف ريی وقطٍ 

 

(23-2) شکل سازی) اتمام ريی وقطٍ ی اوفصال ايل( وتیجٍ شبیٍ 

ایؼتذ. دس ٟ٘بیت یه  ٔیی ا٘فلبَ دْٚ  دٚثبسٜ وّیذ اخشا سا صدٜ ٚ ایٗ دفقٝ اخشا سٚی ٘مغٝ
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 ؿٛد. ٔیػبصی تىٕیُ  ص٘یٓ ٚ ؿجیٝ ٔیثبس دیٍش وّیذ اخشا سا 

 

(24-2) شکل ی اوفصال ديم اجرا تا وقطٍ 

 

(25-2) شکل اجرای وُایی 

سا د٘جبَ ؿٛد تٛخٝ وشدٜ ٚ سفتبس عشاحی  ٔیؽبٞش  Consoleیی وٝ دس ٞب دس ٞش اخشا ثٝ پیبْ

 وٙیذ.
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 اجرای قذم بٍ قذم -2-3-3

ISim  ػبصی لذْ ثٝ لذْ ثب سفتٗ سٚی  وٙذ وٝ دس آٖ ؿجیٝ ٔیثٝ وبسثش پیـٟٙبد  ػبصی ؿجیٝ٘ٛفی

ی ا٘فلبَ لشاس دادٜ ؿذٜ اػت. ثشای  ٞش خظ وذ خّٛ سفتٝ ٚ ٔثُ ایٗ اػت وٝ دس ٞش خظ یه ٘مغٝ

ػبصی ثٟشٜ  ثشای ایٗ ٘ٛؿ ؿجیٝ  دٚثبسٜ سا ثض٘یذ ٚ اص وّیذ ؿاػتفبدٜ اص ایٗ أىبٖ یه ثبس ؿشٚ

ػبصی ثبیذ ایٗ وّیذ سا ثض٘یذ. دلت وٙیذ تب خبیی وٝ دس  ثٍیشیذ ثشای ٞش خؼ خّٛ سفتٗ ؿجیٝ

ی ٞب ی ؿىُ ٔٛج اتفبق ٕ٘یبفتذ. ؿىُ ٔمذاس دادٜ ٘ـذٜ تغییشی دس پٙدشٜ ٞب ػیٍٙبَثٝ  Testbenchفبیُ

 دٞذ. ٔیسا ٘ـبٖ  ٞب ٔٛجُ ؿىصیش اِٚیٗ ٘مغٝ تغییش 

 

(26-2) شکل (َا مًج شکلاجرای قذم بٍ قذم ) ايلیه وقطٍ تغییر در  
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َا مًج شکلايلیه تغییر   (27-2) شکل



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 نامهواشه
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A 

Automatic اتٛٔبتیه، خٛدوبس 

B 

Breakpoint  ٝی ا٘فلبَ ٘مغ 

C 

Clock Region 
 ٘بحیٝ ی ػبفت

Constraint 
 ٔحذٚدیت

Core Generator 
    ی ٞؼتٝ تِٛیذوٙٙذٜ

D 

Debugging 
 صدایی اؿىبَ

Design Analysis 
 آ٘بِیض عشاحی

Design Rule Check 
 ثشسػی لٛا٘یٗ عشاحی

Drag and Drop 
 وـیذٖ ٚ ا٘ذاختٗ

Dynamic 
 پٛیب

E 

F 
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Full View ُٔدیذ وب 

G 

Generate ٖتِٛیذ وشد 

H 

Hardare Design Level افضاس عشاحی دس ػغح ػخت 

I 

I/O Pin Planing ٞبی  سیضی پبیٝ عشحI/O                                                                       

Information     اعلافبت 

J 

K 

L 

M 

Manual 
                                                                                    دػتی

Marker 
 ٌزاس ٘ـبٖ

Math Functions 
 تٛاثـ سیبضی

N 
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Noise َاختلا 

O 

Objects اؿیب 

P 

Part Selection 
                                                                                                   ا٘تخبة ثخؾ

Planning 
                    سیضی عشح

Q 

R 

Restart   ٜؿشٚؿ دٚثبس 

S 

Sequentially 
 پی دس پی

Signal Integrity 
                            تٕبٔیت فلائٓ

Simultaneous Switching Noise 
 صٔبٖ اختلاَ ٘بؿی اص تغییش ٞٓ

Simultaneous Switching Output 
 صٔبٖ خشٚخی تغییش ٞٓ

Spreadsheet 
                                                                                           ی ٌؼتشدٜ كفحٝ

Static 
 ایؼتب

Sub-Module 
                                                                                           ٚاحذصیش 
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Subtractor 
                                                                                            وٙٙذٜ تفشیك

T 

Tab 
 ثشٌٝ

Toolbar 
                                                                                       ٔٙٛی اكّی

U 

V 

W 

Weighted Average Simultaneous Switching Output  ٖصٔبٖ خشٚخی تغییش ٞٓداس  ٔیبٍ٘یٗ ٚص 

X 

Y 

Z 

Zoom 
 ثضسٌٕٙبیی

                        


